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Preface

Welcome to the GV-Web Report User’'s Manual.

This Manual is designed for the following software version:

Product Version
GV-Web Report V2.2.4.0

Note for Age and Gender Recognition Results:

In GV-Web Report, functions involving age and gender recognition results are only functional
when connecting to GV-Smart Boxes with firmware version 1.0.
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Naming and Definition

GV-System

GeoVision analog and digital video recording software. In most
documents, the GV-System also refers to Multicam System, GV-
NVR System and GV-Hybrid DVR System at the same time.

GV-Smart Box

The GV-Smart Box is a standalone device featuring People
Counting, Face Counting and Object Size Counting functions.
Through the Web browser, the GV-Smart Box delivers live view, face
snapshots and counting results.

GV-3D People
Counter

The GV-3D People Counter integrates Asus Xtion Pro / Asus Xtion
Pro Live to count and analyze the number of people passing by in
the designated detection area. A built-in Web interface, the GV-Web
Report Lite provides you with an easy setup and accurate people
counting results.
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Chapter 1 Introduction

The GV-Web Report is designed to integrate and analyze counting data from GV-3D People
Counters, GV-Systems, and GV-Smart Boxes. Suitable for large-scale video surveillance
deployments, it can receive data from up to 1000 units of GV-3D People Counters, GV-
Systems and GV-Smart Boxes.

Through the Web interface of GV-Web Report, you can access the reports and graphs of
real-time, hourly, daily, monthly and yearly statistics on people counts, vehicle counts and
face counts. You can also view the live video and the recordings from multiple locations.

GV-System (dbSync 2
y ( y ) Up to 1000 units

GV-Smart Box

Send people / vehicle / face
Send people / face counting data and live video

Send people

counting data
counting data, live video g

and recordings l
GV-Web Report Serve

g ’ Access counting data, \

live video and recorded files

‘,__J .
User User
(IE browser) (IE browser)

Figure 1-1
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Features

e Support for up to 1000 units of GV-3D People Counters, GV-Systems and GV-Smart
Boxes.

e People counting results from GV-3D People Counters, GV-Systems, and GV-Smart
Boxes

e Face counting results and snapshots from GV-Systems and GV-Smart Boxes
e Vehicle counting results based on different object sizes from GV-Smart Boxes
e Real-time, daily, monthly, yearly counting reports and graphs

e E-mail notification and 1/O trigger when the number of people remaining reaches the
specified maximum

e Counting results query from iPhone, iPad and other Android-based mobile devices
¢ Grouping function to combine desired devices’ cameras for data analysis
¢ Remote playback of recordings from GV-Systems

e 4 languages supported: English, Russian, Simplified Chinese, Traditional Chinese
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1.1 Minimum System Requirements

The following are minimum system requirements for the server to run GV-Web Report, and
for the GV-System to run dbSync 2 in order to connect to GV-Web Report.

GV-System
GV-System V8.3.2 or later
Software .Net Framework 3.5
dbSync2

Note: .Net Framework and dbSync2 can be found in the accompanying software CD.

GV-Web Report

32-bit | Windows XP / Vista / 7 / Server 2003 / Server 2008
OS Supported
64-bit | Windows 7 / Server 2008
Software .Net Framework 3.5
Browser Internet Explorer 7.0 or later
Hardware External or Internal GV-USB Dongle
Note:

1. .Net Framework can be found in the accompanying software CD.

2. Itis recommended to use the internal GV-USB Dongle to have the Hardware
Watchdog function which restarts the PC when Windows crashes or freezes.

Software License

Free License N/A

Maximum License 1000 clients

Increment for )
: 200, 500 or 1000 clients
Each License

Optional Combinations | N/A

Dongle Type Internal or external

Note: The Maximum License is a paid service.
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Compatible Versions of GeoVision Application
The GV-3D People Counter compatible with GV-Web Report V2.2.3.0 and V2.2.4.0 are listed

below.
GV-3D People Counter
GV-Web Report V2.2.3.0 V1.01
GV-Web Report V2.2.4.0 V1.02 or later
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Chapter 2 Installation

2.1 Installing the GV-Web Report

The GV-Web Report program can be installed on a separate computer or on the same
computer with the GV-System. It is recommended to install on a dedicated computer.

Before installing the GV-Web Report, you need to install the USB dongle driver and .Net
Framework first. Follow the steps below to install the programs.

1. Insert Software CD to the computer. This window pops up automatically.

ﬁ V2240 G¥-Web Report Install program

Q GeoUision:

Install Geo¥ision ¥2.2.4.0 1. Install or Remove GeoVision GY-Series Driver
G¥-¥Web Report System to your
PC. 2. Install Direct¥ 9.0c

3. Install Microsoft .NET Framework 3.5

4. Install GeoVision GV-Web Report System
5. Install GeoVision Content Designer

6. Install Geo¥ision GV-IP Device Utility

7. Browse User's Manual [PDF Format]

8. Download Adobe Acrobat Reader

Figure 2-1

2. Toinstall the USB driver, select Install or Remove GeoVision GV-Series Driver and
click Install GeoVision USB Devices Driver to start.

3. Toinstall the .Net Framework, select Install Microsoft. NET Framework 3.5 to start.

4. To install the GV-Web Report, select Install GeoVision GV-Web Report System and
click GeoVision GV-Web Report System to start.
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2.2 Installing dbSync2 on the GV-System

To send people counting data from GV-System to GV-Web Report, it is required to install the
dbSync2 program on the GV-System. Follow the steps below to install the program.

1. Insert the Software CD to the computer. The Install Program window (Figure 2-1) pops

up automatically.

2. Toinstall the .Net Framework, select Install Microsoft. NET Framework 3.5 to start.

3. Toinstall the dySync2, select Install GeoVision GV-Web Report System and click
dySync2 to start.
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Chapter 3 Getting Started

The GV-Web Report server is a dedicated computer on a network that analyzes the counting
data from GV-3D People Counters, GV-Systems and GV-Smart Boxes. The GV-Web Report
server enables you to access the analysis data anywhere through a Web browser.

3.1 Starting the GV-Web Report

To start the GV-Web Report service, follow the steps below:

1. Run the GV-Web Report (from Windows Start menu or from your desktop). For the
first-time user, you will be prompted to type a password. The default ID (account) is
admin.

2.  Onthe GV-Web Report window, click Service from the menu bar and select Data
Service to start receiving data from connected GV-3D People Counters, GV-Systems
and GV-Smart Boxes.
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3.2 Connecting GV-3D People Counter to GV-Web Report

To send people counts from a GV-3D People Counter to the GV-Web Report server, you

need to configure the settings in the Web interface of the GV-3D People Counter to allow

connection to the GV-Web Report. For details, see Chapter 4 The Web Interface in GV-3D

People Counter User’s Manual.

1.

In the Web interface of the GV-3D People Counter, click the Setup tab on the top.

2. Under the Detection Setting page, select Report to Server.

Liveview | REC

People Counter Settings

xtion Device Height: IZBD cm Range: 180~500cm

Minimum People Height: |1DD cm Range: (80 ~ 220)cm
People between 100~220 cm can be detected | Detail

¢ I\yrong Direction Alarm
‘ © In(Exit Only)  © Out (Enter Only) ‘

Direction Change: Change

(Green: In, Red: Qut)

W TIME MEM

Machine Mame: |GV—3D People Counter 1

Login Mame: |admin Port: | 30003 Default 300032

Report to Other Server

~ M Repart to Server 1
© Time Sync IP: [192.168.3.184 | Port: | 30000

Marme: Iadmin Password: I

r I Report to Server 2
€ Time Sync Ip: [192.168.5.130  Port: | 30003

Marme: Iadmin Password: I -----

Passward: |seses Canfirm Pw: I - I Report to Server 3
Output: |VGA 'I Resolution: |1366><?6El 'I © Time Sync Ip;l por-t:l 30003
Timezone: |UTC+DEI:DD 'I Apply | —— I— E— I—
Reset | Save |
Figure 3-1

Type the IP address of the GV-Web Report, and modify the default Port 30003 if

necessary.

Type the Name and the Password to access the GV-Web Report.

If you click Time Sync under one of the servers, the time of the current GV-3D People
Counter will be synchronized with the selected server. To cancel time synchronization,

double-click the selected radio button.
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Note:

1. GV-Web Report V2.2.3.0 is only compatible with GV-3D People Counter V1.01, and
GV-Web Report V2.2.4.0 is only compatible with GV-3D People Counter V1.02 or later.

2. To access GV-3D People Counter through a Web browser, make sure your PC is in
good network connection, and use one of the following web browsers:

o Mozilla Firefox V16.0.2 or later
e Google Chrome V22.0.1.1229.94 or later
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3.3 Connecting GV-System to GV-Web Report

To send people counting results from a GV-System to the GV-Web Report server, you need
to run the dbSync2 program on the computer of GV-System. To send face counting results
from GV-Systems to the GV-Web Report, use the Face Count function of the GV-System.

Note: To send face counting results from a GV-Systems to the GV-Web Report, the GV-
System must be of version 8.4.0.0 or later and an AVP dongle is required for GV-System
version 8.4.0.0 to 8.5.5.0.

3.3.1 Configuring the dbSync2 Program on GV-System

The dbSync2 program, installed on the computer of GV-System, sends people counts to the
GV-Web Report server. It also enables remote access to the GV-System for live video and
playback applications.

1. Run dbSync2. This dialog box appears.

dbSync2

Synchranization time:

Daily Syne. Time

Time [12:00:00 =]

Update Interval

Run at Startup

Setting | ‘ Batch | ‘ [8]54 ‘ | Exit |

Figure 3-2

m Daily Sync. Time: Specify a time to send the counts to the GV-Web Report server
automatically.

m  Update Interval: Specify a time interval in minute to send the counts to the GV-Web
Report server automatically.

m  Sync: Click this button to send the counts to the GV-Web Report server immediately.

10
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m  Batch: Click this button, and select the desired data files to be sent to the GV-Web
Report server. The files of people counts are named with prefix "sys", e.g.
sys20071127. The default path for data files is: \GV folder\database.

m  Setting: Click this button to configure connections to the GV-Web Report server.
2. Click the Setting button. This dialog box appears.

k= Setting E|

Sync Configuration

Datahase Path: | CAGW-B0MDatabase

Gy-YWeb Report Configuration
IP Address : 192.158.2.58|

Port: 30000

Uzer Mame . admin

Password . |=

DWR Configuration(For remaote access)
IP Address: 192.168.0151
Command Port. | 4550

Data Port: 55450
Audio Port: G550

Viewlog Por: Aa52

J=zer Mamea 1
Fazsword : -

Figure 3-3

[Sync Configuration] Displays the database path. The default path for database is: \GV
folder\database.

[GV-Web Report Configuration] Type the connection information of the GV-Web
Report server, including its IP address, login username and password. The default port
value is 30000. Click Test to ensure the connection information is correct.

11
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[DVR Configuration for Remote Access] The configuration allows remote access to
the live video and the recordings of GV-System. Before the configuration, enable
WebCam Server on the GV-System first so that the dbSync2 program can automatically
acquire the necessary port values (Common Port, Data Port, Audio Port and Viewing
Port) from the GV-System. Enter the IP address, login username and password of the
GV-System. Then click Update to send the configuration values to the GV-Web Report

server.

3. Click OK. The dbSync2 program is minimized to the notification area.

*, ' ot B3l P
¥

When people counts are logged to the GV-System, the dbSync2 program will send data to
the GV-Web Report server at the specified time or time interval each day. You can not only
query counting data, but also view live video and recordings through an IE browser

anywhere.

12
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3.3.2 Sending People Counting Results
1. Run dbSync2 (from Windows Start menu or from the desktop). This dialog box appears.

dbSync2

Synchronization time:

Daily Sync, Time

Time [12:00:00 =)

Update Interval

Run at Startup

Setting | [ Batch l ‘ Gk ‘ | Enit |

Figure 3-4

2. Click the Setting button. This dialog box appears.

Syne Configuration

Database Path: | CAsv-800\Database |

Giy-Web Report Configuration

IP Address © [192.168 2.58] L[ Test |

Port: [30000 |

User Mame : |admin |

Passward : |*‘m* |

DR Configuration{F ar remote access)
IP Address: |1 92.168.0.151

Command Port: 4550

Data Port:
£udio Port
Wiewlog Port;
User Mame : |1 |
Password : |* |

Figure 3-5

13



Q GeoUision:

3. Inthe GV-Web Report Configuration section, type the IP address, username and
password of the GV-Web Report server. Keep the port 30000 or modify it if necessary.
The port value must match the port of GV-Web Report server (Figure 3-10). For details
on account settings on the GV-Web Report server, see 3.6.2 Account Settings.

4. Click Test to connect to the GV-Web Report server. If the connection is established, a
successful connection message will appear on both the GV-System and the GV-Web
Report.

Note: Ensure that the GV-Web Report service has been started (see 3.1 Starting the GV-
Web Report). Otherwise, the connection attempt will fail.

5. Since the dbSync2 program only sends the logged counts to the GV-Web Report server,
it is required to configure the Update the log every x Min. option in the
Counter/Intrusion Alarm Setting on the GV-System. Based on the specified interval in
minute, the counts are logged to the GV-System and will be sent to the GV-Web Report
server through the dbSync2 program.

Camera Applied as Counter. E|
Chooze Camera [ max. 16
Configure...
W 1 [ s [ 9 [ 13
Clear &l
[ 2 1 6 [ 10 [ 14
[ 3T 71 111 15
[8]34
[ 4 T 81 12 [ 16
Cancel

v Update the Log every: & |1 b

© at each Clack Hour

[v Showe Object
...................... IECT ¢ @ @ @

Figure 3-6

To define a specific time to send people counts to the GV-Web Report server, see 3.3.1
Configuring the dbSync2 Program on GV-System.

14
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3.3.3 Sending Face Counting Results

To send face counting results from GV-Systems to GV-Web Report, GV-System must be of
version 8.4.0.0 or later and an AVP dongle is required for GV-System version 8.4.0.0 to
8.5.5.0. Make sure remote access to GV-Systems has been enabled on GV-Web Report.
See 3.6.3 Remote Access Settings for details.

1. On the GV-System, click the Configure button, select Advanced Video Analysis and
select Face Count Setting.

2. Select the cameras you want to configure and click Configure. This dialog box appears.

Face Count gl
W Camera =
Camera Selection
o
Carmera 1 - ]

N
Definition

= Mask Region
" Detected Face Size
o

Setting
Alarm Type

Option

Reset at 1z o'clock

I—
Sensitivity 3
[ Sawe counting results to Gv-\Weh Report
— |
- |
— 2 [T | T
Schadule ‘ Test |@ g i
0K | Cancel |
Figure 3-7

3. Select Face Count under Alarm Type.

4. In the Option section, select Save counting results to GV-Web Report. A dialog box
appears.

Domain Mame or IF |
Addrass
Port |
Usertbame |
Pagsword |
Test cancel
Figure 3-8

5. Type the Domain Name or IP Address, Port, UserName, and Password of the GV-
Web Report. The default port number is 30000. For details on account settings on the
GV-Web Report server, see 3.6.2 Account Settings.

6. Click OK.

15
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3.4 Connecting GV-Smart Box to GV-Web Report

To send people counts, face counts, and object size counts from a GV-Smart Box to the GV-
Web Report server, you need to configure the GV-Smart Box to allow connection to GV-Web
Report. For details, see the Connecting to GV-Web Report section in GV-Smart Box User’s

Manual.

1. Select Events and Alerts and then Web Report Setting in the Web interface of the
GV-Smart Box. This page appears.

Web Report

In this section you can configure the connection to Web Report.

Web Report

[#*]Enable
Host name or IP Address [192168.0.123

Fort Mumber a0ooo
User Mame 1

Fasswaord .

Connection Status

Status: Connected. Connected TirmeWYed Moy 3 11:47:22 2010

Figure 3-9
2. Enable the Web Report function.

3. Enter the IP address of the GV-Web Report server, and the login username and

password.

4. Click Apply.

The Connection Status is shown on the bottom of the page displaying the GV-Web
Report’s connection status and the connection time.

16



K} Getting Started

3.5 The Main Screen of GV-Web Report

& GeoVision GY-Web Rzport

Service Browse Tools  Help

o——a R TESTI 51 [ 2 Events

ﬁ 2 :eu-_: Onlinet) Time Account | Device IF Address Action Result
E GY-Srmart Box || 2010-06-1513:31:45 1 GV-Smart Box-PF 1921680106 Dewice Login. Success
!_ﬁ, 2010-06-1513:31:39 admin GW-Smart Box 192 168.2.98 Device Login. Success
=l GV-3D People

& offline(m)

[Ead

| >

Figure 3-10
No | Name Description
1 Host List Displays connected hosts.
2 Event List Displays the connection information.
3 | Service Enables and disables the GV-Web Report services.

m Data Service: Allows connection to GV-3D People Counters, GV-
Systems and GV-Smart Boxes.

m  Web Service: Accesses to the GV-Web Report’'s Web Interface.
Allows remote access to live video as well as recordings of GV-
System, face snapshots captured from GV-Smart Boxes, and
people counting data from GV-3D People Counters.

4 Browse Links to the Web interface of the GV-Web Report.
5 | Tools Accesses the advanced settings. See 3.6 Configuring the GV-Web
Report.

17
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3.6 Configuring the GV-Web Report

To access more settings of the GV-Web Report server, click Tools (No. 5, Figure 3-9) on
the main screen. The following sections describe advanced settings: General Settings,
Account Settings, Remote Access Settings, Database Settings, E-Mail Settings, and UPnP
Port Mapping Settings.

3.6.1 General Settings

The General Settings allow you to configure the communication ports of the GV-Web Report
server and automatic startup services.

%# General Setup @

Data Server
Server Name: TEST151

Listen Paort 30000

Max Client Limit (100 (Wax value is 200%
[ Auta Start Service

Weh Server

Listen Port |20

[ Auta Start Service

[ Auto startup after login Windows
[] Startup Auta Login

Resetto default

Apply

Figure 3-11
[Data Server]

m  Server Name: Defines the name of the GV-Web Report server. The default value is the
computer name.

m Listen Port: The default port value of the GV-Web Report server is 30000. The port
value must match the GV-Web Report related port on a GV-3D People Counter (Figure
3-1), GV-System (Figure 3-2) and GV-Smart Box (Figure 3-8).

m  Max Client Limit: Defines the maximum number of GV-3D People Counters, GV-
Systems and GV-Smart Boxes that can be connected to the GV-Web Report. The

maximum value is shown on the right.

m  Auto Start Service: Automatically starts connection to GV-3D People Counters, GV-
Systems and GV-Smart Boxes once the GV-Web Report server is started.

18
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[Web Server]

m Listen Port: The default port value is 80. The HTTP port enables connecting the GV-
Web Report server to the Web.

m Auto Start Service: Automatically starts the remote access to GV-Systems and GV-
Smart Boxes.

m Auto startup after Windows login: Automatically starts the GV-Web Report server after
Windows startup.

m Start Auto login: Automatically log into the GV-Web Report server after Windows
startup. Click the Arrow button to enter the login account and password.

3.6.2 Account Settings

The GV-Web Report supervisor can create new accounts with different access rights. The
supervisor account has the privilege to log into the GV-Web Report and make configuration
settings, while the user account is only allowed to access the GV-Web Report Web interface.
The maximum account number for supervisor and user accounts is 100.

Account Lzer Setting

Users(O) Account
= Bupervigors(l)

admin

Mew Password

Canfirm Mew Password

Apply

General Setup | Ghvyeb Report
Allow Web Login

Allow Remote Playback
Allow Live View

Figure 3-12

For details on the Allow Group Setting option in the GV-Web Report tab, see 4.2 Group
Page.

19
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3.6.3 Remote Access Settings

The Remote Access Settings display the available GV-Systems and GV-Smart Boxes for
remote access to their live video, recordings, and face snapshots through the Web browser.
The asterisk *x on the State column indicates that the account name and password are
required for access to the specific device. To allow remote access to the GV-Systems or
GV-Smart Boxes, select the device on the list and then type its login account name and

password.
E8| Remote Access Setting @
Dievice
State Device Type Device IP Address Account

GEOWISIO-TYFECD  192.168.2.1249
AlexLocalCVE 192.168.0.227

DvR 192.168.2.160
TEST144-DF9EDC2  192.168.0.226
TEET16 192.168.0.186

a8 127.0.01

I

< | >

Remote Access Setting
Gommand Part: (4550

|

Videa Port  |5550 |

Audio Port  |B5S0 |

ViewLog Port  |5662 |

Account |1 |
Passward |* |
l Reset to default I l Apply ]

Figure 3-13

20
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You can modify the storage path of the GV-Web Report database, specify the number of

days to keep the database, and change the storage path of face snapshots from GV-Smart

Boxes.

If the computer of the GV-Web Report server is of NTFS file system, you can select Enable

Database Compression to save disk space.

Database

Setting

Path IMProgram FilesiGeoy D
Keep Days (0: unlimited)

Snapshot Folder: |IAProgram FilesiGeoy D

Figure 3-14

3.6.5 E-Mail Settings

You can send e-mails to the supervisor when the connection of any GV-3D People Counter,

GV-System or GV-Smart Box is lost. You can also send e-mail notifications when the pre-

defined maximum number of people is reached. See 4.2 Group Page on how to set the

maximum.

E-Mail Setting 3

E-Mail Setting

SMTF Server: |

From |

TO |

Subject |

Account | | [ ssL

Passward | |

Test E-Mail Account

SMTF Authentication Setting SMTF Sener Setting

[] SMTF Mail Server requires authentication SMTP Port

Figure 3-15
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3.6.5.1 Setting Mail Server

1. Type URL or IP address of the SMTP server.
2. Type the sender e-mail address.

3. Type the recipient e-mail address. For multiple recipients, add a semicolon between
each e-mail address.

4. Type a subject regarding an alert message.

5. Click Test E-Mail Account to send out a test e-mail to see whether the setup is
complete. If not, you may also need to check the SMTP Authentication Setting and
SMTP Server Settings described below.

Other options on the dialog box:

[SMTP Authentication Setting] If your e-mail service provider requires an authentication for
sending e-mails, select this option and type your SMTP account ID and password.

[SMTP Server Setting]
m  SMTP Port: Type the SMTP port value. The default value is 25.

m  SSL: If your e-mail server requires an SSL (Secure Sockets Layer) authentication for
connection, select this option.

3.6.5.2 Setting E-Mail Alert

When a GV-3D People Counter, GV-System or GV-Smart Box is disconnected from the GV-
Web Report, the e-mail will be sent out to warn the supervisor. Follow the steps below to set
the e-mail alert.

1. Right-click the host in the host list and select Host Setting.

D.‘; GeoVision GV-Web Report

Service  Browse  Tools  Help

= £ TeEsTIs 2l Events
E Online Tirme Account
=8 Offline(2)
E GY-Smart Box

GY-Smart Box-PP

Host Setting

Figure 3-16
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Enable Send E-Mail Notification when disconnected, and click OK.

Host Setting

Notification |
Send E-Mail Motification when disconnected.
E-Mail Setting

Figure 3-17
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3.6.6 UPnP Port Mapping Settings

The GV-Web Report server supports UPnP technology (Universal Plug and Play) to allow
automatic port configuration to your router.

The following requirements must be met to enable UPnP:

e Windows XP Service Pack 2 or later

e Windows operating system has been configured to use UPnP (see Enabling UPnP in
Windows XP, Appendix)

e UPnNP has been enabled on your router (consult your router’'s documentation)

To enable UPnP on the GV-Web Report:

1. Click Tools from the menu bar and select UPnP Port Mapping Setting. This dialog box

appears.
UPnP-hased Router
| Name | Port IP Addrass NOTE |
s GY-eh Report Port 30000 192.168.2.168
_~ Weh Server Port a080 192.168.2.168
< >
20:41:01- Mo UPnP devices available
20:40:58- Searching for UPnP enabled routers
Figure 3-18

2. Click Searching to search the UPnP-enabled routers.

3. If your server is installed with more than one router, select a desired one from the UPnP-
based Router drop-down list.

4. If you server is installed with more than one network adapter, select a desired one from
the drop-down list.

5. Click Configure to automatically configure the communication ports on the router.

Tip: If you don’t use the default ports, modify the related ports in the General Settings dialog
box (Figure 3-11), re-open the UPnP Port Mapping dialog box and follow the steps above to
configure your router.
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3.7 Accessing the Web Interface

To access counting results through the Web interface, ensure that Web Service on the GV-

Web Report server has been enabled as shown below; otherwise the login through the Web
browser will fail.

& GeoVision GV-Web Report

Service | Browse Tools  Help

Start all senvices

Stop all seniices

Data Service
YWehb Service

[<][<]

Logout
Exit

Figure 3-19

1. Two methods to access the Web interface of GV-Web Report:

A. If you are at the local GV-Web Report server, select Browse on the main screen of

the GV-Web Report (Figure 3-9) and select GV-Web Report Data. The login page
appears.

@ ~ [el 127.0.0.1 _

File Edit View Favorites Toolks  Help

i Favortes | 35 (@ ~ ] FreeHotmail £

& Loan

(2 Geovision

Sign In with your account

Enter the

characters shown 3168

inthe image :

Remember my Account and
Password

©2009 GEOVISION INC.ALL RIGHTS RESERVED.

Figure 3-20

B. If you are at a remote computer, open the Internet Explorer browser. Type the IP
address or of the GV-Web Report domain name in the Location /Address field of your
browser. The login page appears.
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2. Type the login ID and Password of the GV-Web Report. The ID and Password should
match any set account in the Account dialog box (Figure 3-11).

3. Type the characters shown in the image.

4. Click Login. The Web page is now displayed on your browser.

People Counting h

(® Geovision GV-Web Report - People Counting

Device | Group | Log | Query | Custom Query User: admin  Logout

@ :0onLine ®:0ffLine
£ Total List
» GV-3D People Counter |eft@[Delete] In 0 In 0 In 324
> GV-3D People Counter@[Delete] Out 0 Out 0 Out 300
> GV-3D People Counter right@
[Delete]
Counting Signage

Total In: 324 | Total Out: 309 | Stay: 15 | Wrong Direction Count: 0

* Update Frequency : 60 sec
’ s Last Updated : 18:17:59
e Total In{Out): on behalf of today 0:00 until now In{Out) « l4Seconds later update

Total Device Real-time In and Qut chart

Figure 3-21

5. To display the graphs, it is required to download Microsoft Silverlight to your computer.
Click the link on the page to start downloading the program.

After starting GV-Web Report Service, you can access the counts, graphics and live video
on the network. The GV-Web Report is shown in 3 pages, People Counting page, Face
Counting page and Object Size Counting page.

¢ People Counting page: provides counting data regarding the number of people stepping
in and out as well as the number of people remaining in the surveillance area from GV-3D

People Counters, GV-Systems and GV-Smart Boxes.

¢ Face Counting page: provides face counting data, and gender and age recognition
results of people in the surveillance area from GV-Systems and GV-Smart Boxes.

¢ Object Size Counting page: provides counting data of vehicles in the surveillance area
sorted by different object sizes from GV-Smart Boxes.
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Chapter 4 Accessing People Counting

Page

After the GV-Web Report Service is started, you can access the counts, graphics and live
video on the network. The GV-Web Report is divided into 3 pages, People Counting page ,
Face Counting page and Object Size Counting page. This chapter describes the functions
on the People Counting page in detail.

The People Counting page provides counting data regarding the number of people in, out
of, and remaining in the surveillance area. The counting data can be acquired from GV-3D
People Counters, GV-Systems and GV-Smart Boxes.

Note: For remote viewing through network, Internet Explorer 7.0 or later is required.

4.1 Device Page

On the Device page, you can access three types of people counts of the current day.

Main page On the main page of the Device page, the people counts of the
current day are updated from the GV-Web Report server every
minute. See 4.1.1 Viewing People Counts Updated Every Minute.

Counting Signage On the Counting Signage page, the people counts of the current
day are updated from the GV-Web Report server immediately. See
4.1.2 Viewing the Current People Counts.

Live View Window On the Live View window, the people counts are updated directly
from a GV-System. You can also view live video from a GV-System
or GV-Smart Box. See 4.1.3 Viewing Live Video.
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4.1.1 Viewing People Counts Updated Every Minute

The data on the main page of the Device page is updated every minute from the GV-Web
Report server. The page displays the people counts and graphs of all connected GV-3D
People Counters, GV-Systems and GV-Smart Boxes.

People Counting h

(® Geovision GV-Web Report - People Counting

User: admin  Logout

Device | Group | Log | Query | Custom Query

@ :0onLine ®:0ffLine
‘GV-3D People Counter left GV-3D People Counter GV-3D People Counter right
In 0 In 0 In

= Total List 124
> GV-3D People Counter left@[Delete]
Qut 0 Qut 0 Qut 309

> GV-3D People Counter@[Delete]

> GV-3D People Counter right@ L o
[Delete]
Counting Signage

Total In: 324 | Total Out: 309 | Stay: 15 | Wrong Direction Count: 0

* Update Frequency : 60 sec
’ s Last Updated : 18:17:59
e Total In{Out): on behalf of today 0:00 until now In{Out) « l4Seconds later update

Total Device Real-time In and Qut chart
50

. N 4

Figure 4-1

The counts on the main page show:

® In: The number of people entered during the day.

m  Out: The number of people left during the day.

m Total In: The total number of entered people detected from multiple devices during the
day.
Total Out: The total number of left people detected from multiple devices during the day.
Stay: The number of remaining people, the subtraction of Total Out from the number of
Total In.

On the left menu, you can find these options:

m Total List: Select one device under the list to access its individual counts. A green mark
indicates that the device is now updating data to the GV-Web Report server; otherwise a
red mark appears. On the individual device’s page, the people counts of the current day
are updated every minute from the GV-Web Report server. To remove a device from the

list, click Delete next to the device name.

© Camera: Access the live video if remote access function is enabled on both the
device and GV-Web Report server. See 4.1.3 Viewing Live Video later in this chapter.
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m  Counting Signage: Access the people counts of the current day updated immediately

from the GV-Web Report server.
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(2 GeoUision

@ :0onLine ®:OffLine
i=Total List

GV-Web Report - People Counting

22,345 In

User: admin

GV-Smart Box GV-3D People Counter
In

1,362

» GV-3D People Counter@®

0

13,041

55

Delete]
» GV-Smart Box@[Delete]
» CAMERA_NAME(Live View)
» TEST-308-PC@[Delete]
» Cam 1(Live View)
» Cam 2(Live View
» Cam 3(Live View
» Cam 4(Live View

Count: 0

» Cam 6(Live View

Total In: 23,707 | Teotal Out: 13,096 | Stay: 10,611 | Wrong Direction

e Total In{Out): on behalf of today 0:00 untl now In{Out)

9,304

5ec

1,307

» Update Frequency : 60

+ Last Updated : 18:48:14
+ 455econds later update

» Cam 7(Live View
» Cam 8(Live View
» Cam 9(Live View)
» Cam 10(Live View)
» Cam 11(Live View)
» Cam 12(Live View)
» Cam 13(Live View)
(
(

)
)
)
» Cam 5(Live View)
)
)
)

» Cam 14(Live View)

» Cam 15(Live View) g

» Cam 16(Live View) 2
— 51
Counting Signage

4,000

3,500

2,000

2,500

2,000

1,500

1,000

S0

a

Total Device Real-time In and Out chart

Logout

Figure 4-2

4.1.2 Viewing the Current People Counts

To view the people counts of the current day continuously updated from the GV-Web Report

server, select Counting Signage from the left menu of the Device page.

&) hitp /11921683 242tApp/Counter._Signage php?T ¥ FE=ALLDEYICE

GV-3D People
Counter left-

GV-3D People
Counter-

GV-3D People
Counter right-

Device Name

N:In/0:out

[ Enable Alarm Sound

Recently Record(20 Records)

Time

n Out

Wrong Direction Count

In 0 In 0 In 326
Out 0 Out 0 Out 313
Stay 0 Stay 0 Stay 13

GV-3D Peaple Counter right

2013-11-07 18:24:17

GV-3D Peaple Counter right

2013-11-07 18:23:44

GV-3D Peaple Counter right

2013-11-07 18:23:12

GV-3D Peaple Counter right

2013-11-07 18:22:17

GV-3D Peaple Counter right

2013-11-07 18:19:43

olrlmlolo
=lolo|w|m

Figure 4-3
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4.1.3 Viewing Live Video
To access live video, select the desired camera from the left menu of the Device page. To
have video streaming, ensure the following settings have been configured or enabled:

e GV-System: WebCam Server and DVR Configuration for Remote Access settings
(Figure 3-7) on dbSync2
e GV-Web Report: Configuration for Remote Access settings (Figure 3-12)

People Count

= Start Time
200912423 15:04:10

L]

11

= Qut
6

= Stay People

> uE

Figure 4-4
By clicking the Start button on the Live View window, you can view the updating counts from
the GV-System.

Note:

1. The In and Out counts on the Live View window is updated directly from the GV-
System instead of the GV-Web Report server.

2. Once the counts are logged into the GV-System, the In and Out counts will become
zero and the GV-System will start counting those numbers again.
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4.2 Group Page

On the Group page, you can group different cameras from different GV-3D People Counters,
GV-Systems and GV-Smart Boxes, and see the people counts of the set group. You can
also set up the maximum number of people entered, left and remaining to activate the
computer alarm. The 1/O trigger and e-mail notification can also be activated when the
number of people remaining reaches the pre-defined maximum.

To set up a group:

1. Select Add Group from the left menu of the Group page. This page appears.

2 Geouisi :
GeoUision GV-Web Report - People Counting
Device | Group | Log | Query | Custom Query User: admin  Logout
4 5 Total List Add Group
> [ Aread4404 GY-Smart Box
- ) Areadzndg Camera [ CAMERA_NAME
Manage Group In Maximum L ]
» Add Group Qut Maximurm ]
» Maintain Group B l:l
» Setting Group Relations Sy T
Manage Email Group Country | V|
» Add Email Group City
» Maintain Email Group Set email for reaching the
; ves & MNo
Manage I/0 Device maxrimum © b
» Add /O Device Set IO trigger for reaching
) "i_ ) the maximum Oves @ho
» Maintain If0 Device
» Counting Signage Submit

Figure 4-5
2. Name the group.
3. Select the cameras that you want to include in the group.

4. In the In Maximum field, set the maximum number of people that can enter during the
day before activating the computer alarm.

5. In the Out Maximum field, set the maximum number of people that can leave during the
day before activating the computer alarm.

6. In the Stay Maximum field, set the maximum number of people that can remain during
the day before activating the computer alarm, sending a natification e-mail or triggering
an output device.

7. Select a Country and a City to specify your location if you are in Taiwan and China. You
can later view count data according to the weather conditions on the day of the data
recording. Note that this function is only supported for Taiwan and China.

31



Q GeoUision:

8. To receive e-mail notifications when the maximum number of people remained is

reached, select Yes for Set email for reaching the maximum.

9. To trigger an output device when the maximum number of people remained is reached,
select Yes for Set I/0 trigger for reaching the maximum.

10. Click Submit.

11. From Total List in the left menu, select the set Group to see the sum of every people
count from the selected cameras.

To organize multiple groups into subgroups, click Setting Group Relations in the left menu.
Drag and drop a group under another group to make it a subgroup.

[ ] - .
(2 Geobision GV-Web Report - People Counting
Device | Group | Log | Query | Custom Query User: admin  Logout
4 Total List 4 5] Setting Group Relations [ Please drag and drop ]
- 094704 45994704
> [ Area94404 4 5 Doelibrary
> [ Area98040 [~ I MorrizonLibrary
[T Dvwinelle
Manage Group [CJPimertel
» Add Group [ Talman
» Maintain Group [C]wLsE
» Setting Group Relations [ Zellerhach
Manage Email Group 4 (2 Areaddand
» add Email Group C‘D_raege"s
» Maintain Email Group il
Manage /O Device ‘ ﬁl.;e;j“adﬂi:ﬂ'&
»Aadd I/0 Device |:|Eluildianl

» Maintain IO Device
» Counting Signage

Figure 4-6
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To set up e-mail notifications:

To receive e-mail notifications when the maximum number of people remaining is reached,
you must first set up the mail server on the GV-Web Report server, and then set up an e-
mail group as below. To set up the mail server to send e-mails, see 3.6.5 E-mail Settings.

1. Select Add Email Group from the left menu of the Group page. This page appears.

C eabis :
Geoision GV-Web Report - People Counting
i | Group | Log | Query User: 1 Logout
> Tatal List Add Email Group
» FAE Email Group
Manage Group
> Add Group Group member email
» Maintain Group =
Manage Email Group JMore than
» &dd Email Group one Iperson r
» Maintain Email Group B ease.
separate with a
M ge I/0 Device g
semicolon
» add /O Device
» Maintain IfO Device
> Caunting Signage

Figure 4-7
2. Name the group.

3. In the Group member email field, type the E-mail address to sent notification to.
Separate multiple e-mail addresses with semicolons.

4. Click Submit.

5. Click Maintain Group to customize the e-mail subject and content. And then click the

Update Group buttonE. Type new e-mail subject and content.

6. Select Maintain Email Group to edit an existing e-mail group. And then click the Update

Group buttonE. Click the Delete Group button 6, to delete an existing group.
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To set up 1/O triggers:

The /0O trigger warns the onsite operator of the GV-Web Report server when the number of
people remaining reaches the pre-defined maximum. The I/O trigger function only supports
these GV I/O devices: GV-I/O Box 4 Ports, 8 Ports and 16 Ports.

Note: The I/O trigger function only supports one output device through a GV-1/0 Box, and
the GV-1/0O Box needs to be connected to the COM port of the GV-Web Report server.

1. Select Add I/O Device from the left menu of the Group page. This page appears.

(2 Geovision GV-Web Report - People Counting

Device | Group | Log | Query | Custom Query

> 0122 Device Name GVIO-USB(3) v
Manage Group Port COM7_ v
> Add Group Address 1%

» Maintain Group

Output Signal Type
Onjo ONfo Pulse
Onjc @njc Pulse
Onjo ONfo Pulse
Onjc @N/c pulse
Onjo Onfo pulse
Onjc @n/cpulse
Onjo Onjo pulse
Output QU] 0 e @ wic pulse
Onjo Onfo pulse
Onjc @nycpulse
Onjo Onfo Pulse
Onjc @N/C Pulse
Onjo ONfo Pulse
Onjc @N/C Pulse
Onjo ONfo Pulse
Onjc @njc Pulse

[ submit | Ca

> Setting Group Relations

@
o

Outputl,

@
5

W
o

Output2.

@
5

w
o

Output3

@
3

@
o

outputs:

@
4

@
o

outputs:

@
3

@
o

output7’

@
5

2 o

@
o

outputs:

@
5

3
a
&

Figure 4-8
2. Select the device name from the drop-down list.
3. Select the corresponding COM port and address for the 1/0 device.

4. Select the output to trigger and select its signal type. For the Pulse type, specify the
amount of time in second you want the output device to be triggered for.

5. Click Submit.

On the left menu of the Group page, you can find these options:

B Total List: Access the people counts of the set groups updated every minute from the
GV-Web Report server.

B Counting Signage: Access the people counts of the set groups updated immediately
from the GV-Web Report server. When the limit of In Maximum, Out Maximum or
Stay Maximum is reached, the warning texts will be displayed on the page and the
computer alarm will be activated too.
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On the Log page, you can view the people counts of a specified time period from GV-3D
People Counters, GV-Systems and GV-Smart Boxes.

People Countin v

Q Geolision

Device | Group | Log | Query | Custom Query

GV-Web Report - People Counting

User: admin

Logout

To search the log data:

& Device: The page show record 1-7 , total number of records : 7
total number of pages : 1
O Group:
Start Time: [2008-12-24 71 00 +; Query Result List
. Device Name | Camera Start Time End Time In | Out| VIDEO CLIP
i El TESTSS (M Camera 1 | 2009-12-24 15:01:13 2009-12-24 15:01:31 |20 31 E
End Time: [2009-12-24 v
TESTSS M Camera 1 | 2009-12-24 15:01:33 2009-12-24 15:02:23 |42 44 E
. w
' TESTSS (M Camera 1 | 2009-12-24 15:02:24 2009-12-24 15:03:24 (42 22 H
SEE e L L TESTSS M Camera 1 | 2009-12-24 15:03:24 2009-12-24 15:04:24 |17 12 i
TESTSS (M Camera 1 | 2009-12-24 15:04:24 2009-12-24 15:05:24 (40| 35 B
TESTSS (M Camera 1 | 2009-12-24 15:05:24 2009-12-24 15:06:24 | 3 | O E
TESTSS (M Camera 1 | 2009-12-24 15:06:24 2009-12-24 15:07:24 (30| 40 H
E @) 8]
Figure 4-9

1. Select a specific GV-3D People Counter, GV-System or a GV-Smart Box from the
Device drop-down list or a created group from the Group drop-down list.

2. Specify Start Time and End Time of the log data.

3. You can select whether to search the DST (Daylight Saving Time) data. Select All
indicates searching all data including DST data, Y indicates searching only DST data

and N indicates not searching DST data.

4. Click Query to display the search results.

To back up the search results in EXCEL, WORD or PDF format, click the icons 2/ [ | & |

at the bottom of the Query Result List.
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4.3.1 Playing Back Recordings

To retrieve recordings, click the Video Clip icon on the Log page. The following playback
window will appear. To have video streaming, ensure the following settings have been
configured or enabled:

o dbSync2: DVR Configuration for Remote Access configured. (Figure 3-7).
e GV-System: WebCam Server with the Run Viewlog Server option enabled

e GV-Web Report: Remote Access settings configured. (Figure 3-12)

Note: The GV-3D People Counter and the GV-Smart Box do not support the playback
function.

2 Camera 4

BA3F2005 2004537 877 4+ &
b

Figure 4-10

Playback scroll

: — Move to prev 5 min

Move to prev 1 min

LU
4“4 pr

Play — Il B W 4 M WM
Pause _ | Move to next 1 min
Stop Move to next 5 min
Home End
Backward Forward
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Right-click the playback window to see the following features:

Play Mode Includes these options:

m  Frame by Frame: Play back video frame by frame.

m  Real Time: Play back video on real time. This mode saves time to
wait for rendering, but may drop frames to provide the visual aspect
of real-time playback.

m  Auto Play Next 5 Minutes: Play back video up to 5 minutes.

®  Audio: Turn on or off the video sound.

Render Includes these options:

m Deinterlace: Convert the interlaced video into non-interlaced video.

m  Scaling: Smoothen the possible mosaic squares when enlarging a
playback video

m  Deblocking: Remove the block-like artifacts from low-quality and
highly compressed video.

m Defog: Enhance image visibility.

m  Stabilizer: Reduce camera shake.

m Text overlay’s camera name and time: Overlay camera name and
time onto the video.

m Text overlay’s POS/GV-Wiegand: Overlay POS or GV-Wiegand
Capture data onto the video.

m  Full Screen: Switch to the full screen view.

Tools

m  Snapshot: Save a video image.
m  Save as AVI: Save a video as avi format.

® Download: Download the video clip to the local computer.
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4.4 Query Page
The Query page provides you with the daily, weekly, monthly and yearly people counting

graphs and tables.

To search the counting data, select a GV-3D People Counter, GV-System or GV-Smart Box
from the Device drop-down list or a created group from the Group drop-down list, specify a

date, and select the options below. Use the Chart drop-down list [chart : [Line Graph | {5 choose
to display the data in bar graph, pie graph or line graph.

Note: Pie graph is not available for the following types of data:
e In/Out Counts per hour and Total Stay
e Total In, Out and Stay per Hour
e In Counts per Hour
e QOut Counts per Hour
e Total Stay per Hour

[Daily Report] Display the counting report of the specified date.

m [In/Out Counts per hour and Total Stay: The hourly number of people entered and left,
and the total number of people remaining until now.

m Difference between In and Out per hour: The hourly number of people remaining.

m Total In, Out and Stay per hour: The total number of people entered, left and remaining
during the day.
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The following figure is an example of the In/Out Counts per hour and Total Stay option.
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The value 16, 179 indicates the count of remaining people until 16 pm is 179.

° L .
(2 Geovision GV-Web Report - People Counting
Device | Group | Log | Query User: 1  Logout
(@ _ [2010-11-01] In/Out Counts per hour and Total Stay(All Device)

Daily Report(2010-11-1)

InfOut Counts per hour and Total 250

Stay

Difference between In and Out per

hour 200 16, 179

Total Qut and Stay per hour

50 \
—

- —

0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23

== In == Oul ="= Total Stay

Time In out Total Stay
0:00 64 40 24

1.00 =) S 26

2:00 64 42 48

3:00 16 7 57

4:00 Fi=) 52 a1

5:00 48 31 ag

6:00 16 El 1035

Figure 4-11

[Weekly Report] Displays the weekly report that contains the data of 7 days before your

specified date.

In Counts per hour: The hourly number of people entered for the week.

Out Counts per hour: The hourly number of people left for the week.

Total Stay per hour: The hourly number of people remaining for the week.

In Percentage per day: The daily percentage of people entered for the week.

In Percentage per hour: The hourly percentage of people entered for the week.

Stay Percentage per hour: The hourly percentage of people remaining for the week.
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The following figure is an example of the In Percentage per hour option. The value 15:00,
65 (9.02%) indicates the total number of entered people at 15 pm every day for the week is
65. The number takes up 9.02 percent of the total people entered for the week.

»» Face Counting

® - 5
(2 Geovision GV-Web Report - People Counting
Device | Group | Log | Query User: 1 Logout
O Graup:

[2010-10-26~2010-11-01] In Percentage per hour(All Device)
Time:

2010-11-1 |

*010-10-26~2010- 15:00, 65(9.02%)

In Counts per hour

Qut Counts per hour

Total Stay per hour

In Percentage per day

In Percentage per hour
Stay Percentage per hour

® 0:00 ® 1:00 @ 2:00 & 3:00 @ 400 & 500 ~ 6:00 @ 7:00 & 8:00 & S:00 & 10:00 & 11:00 & 12:00
@ 13:00 14:00 @ 15:00 16:00 @ 17:00 18:00 @ 15:00 @ 20:00  21:00 @ 22:00 @ 23:00

Time In Percentage®

g:00 G4 8.88

1:00 S| 0.69

2:00 64 g8.88

3:00 16 2.22

400 76 10,54

5:00 48 6.66

G:00 16 2.22

Figure 4-12

[Monthly Report] Displays the monthly report that contains the data of 30 days before your
specified date.

m In Percentage per day: The daily percentage of people entered in the month.
m In Percentage per hour: The hourly percentage of people entered in the month.

m Stay Percentage per hour: The hourly percentage of people remaining in the month.

[Yearly Report] Display the yearly report that contains the data of 365 days before your
specified date.

m In Percentage per month: The monthly percentage of people entered in the year.
m  Out Percentage per hour: The hourly percentage of people entered in the year.

m Stay Percentage per hour: The hourly percentage of people remaining in the year.
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4.5 Custom Query Page

The Custom Query page allows you to look up the counting data during a specific period of
time or according to different types of weather. You can customize the X Axis and Y Axis of
the line graph.

1. Select a GV-3D People Counter, GV-System or GV-Smart Box from the Device drop-
down list or select a created group from the Group drop-down list

2. Set a Start Time and End Time to filter the counting data.

3. Toinclude only the data from specific time and days of the week, click Setting next to
Work Date. This window appears.

% Work dateSetting
sun) |06 v|.[05 v| .[14 v |05 v|
o) [00 ][00 ) - 22 v

Tue) (00 v :[00 v|~ |24 v/

=

=]

<

=

Thu) [00 | :[00 | [24 ¥
Fri) [00 % :[00 |~ [24 v .
sat) |00 v|:[00 v . |24 v].

=

=

(
(
(
(Wed) |00 ¥[.[00 v|. 24 v/
(
(
(

=

Close window

Figure 4-13

Specify the days of week and time range to include and click Submit.
5.  You can setthe Y Axis of the line graph to the following options:

B In: Shows the average number of people entered.

B Out: Shows the average number of people exited.

Stay: Shows the average number of people remaining.

B Total In: Shows the total number of people entered.

B Total Out: Shows the total number of people exited.

B Total Stay: Shows the total number of people remaining.
6. You can set the X Axis of the line graph to the following options:

B Per hour: Shows the counting data per hour.

B Per day: Shows the counting data per day.

B Per month: Shows the counting data per month.

B Per year: Shows the counting data per year.
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B Weather: Shows the counting data according to different types of weather. This
option is only supported for Taiwan and China.

Note:
1.  The Weather option is only available when
e Group is selected in step 1.

e The Country and City options are specified in the Group page. See 4.2 Group
Page for details.

e GV-Web Report is connected to the Internet.
2. The weather conditions are updated everyday at 12:00 noon.

7. Click Query to see the line graph.

In the example below, In is selected for Y Axis and Weather is selected for X Axis. The value
Haze, 13 indicates that the number of people entered during hazy weather is 13.

People Counting [i]

¢ ;
GeoUision GV-Web Report - People Counting
Device | Group | Log | Query | Custom Query User: admin  Logout
ngce‘ Select All
: In{Weather)
® M select all 14 haze, 13
Group: 123
start[012-02-13 [ (00w =
Time: |00 [+ | 00 ~|
ena[z01z-02 131 23 ] N
Time: .
" 59w |: 59 v | .
orl
date: Setting
¥ Axis: |In [ﬂ °
X Axis: | Weather [1] o
2
’ & o S - 5 -
£ & &
e,e'*‘ o“é b“Qh . & 85§ o‘a bo»:’ @\5' é‘-"‘& bdéoév &oé“ f £ @ b"é‘ e & q@&.
7
@ﬁ’ d’iﬁ\’g}f 1“@ & w\‘o ‘?f’
& € & & K a‘f
Figure 4-14
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Chapter 5 Accessing Face Counting Page

After the GV-Web Report Service is started, you can access the counts, graphics and live
video on the network. The GV-Web Report is divided into 3 pages, People Counting page,
Face Counting page and Object Size Counting page. This chapter describes the functions
on the Face Counting page in detail.

Face Counting page provides face counting data, and gender and age recognition results of
people entered the surveillance area. The counting data can be from GV-Systems and GV-
Smart Boxes.

After logging in the Web interface, click the Face Counting tab on the upper right corner of
the Web page. The Web page is switched to the Face Counting page similar to the following
example.

(2 Geovision GV-Web Report - Face Counting

Device | Group | Log | Query | Custom Query User: admin  Logout

@ :0nLine ®: OffLine

S TEST-308-PC V-Smart Box ml People Counter
: Face Face Face
> GV-3D People.ciaunlter.,De\ete] el 100 e O e |2
> GV-Smart Eo;_,De‘ ete] Male |0 Male |0 Male |0
> TEST-308-PC@[Delete] =n Female |0 Female |0
nja_ 120 nfa_ |0 nja_ |0

Total Male Count: 0 | Total Female Count: 0

« Total Male(Female): on behalf of today 0:00 until now male(female) count : Egsdtaﬁiggiggelnfgl:zgplgec

s 44Seconds later update

Total Device Real-time Male and Female of Time-Sharing chart
S0

80
70
&0
50
40
20

20

Figure 5-1

Note:

1. Functions involving age and gender recognition results are only functional when
connecting to GV-Smart Boxes using firmware version 1.0.

2. The Face Counting function is only supported in GV-System version 8.4.0.0 or later.
3. For remote viewing through network, Internet Explorer 7.0 or later is required.
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5.1 Device Page

On the Device page, you can access two types of face counts of the current day.

Main page

On the main page of the Device page, the face counts of the
current day are updated from the GV-Web Report server every
minute. See 5.1.1 Viewing Face Counts Updated Every Minute.

Live View Window

On the Live View window, you can view live video from a GV-Smart
Box or GV-System. See 5.1.2 Viewing Live Video.

5.1.1 Viewing Face Counts Updated Every Minute

The data on the main page of the Device page is updated every minute from the GV-Web

Report server. The page displays the face counts and graphs of all connected GV-Smart

Boxes and GV-Systems.

(2 GeoUision GV-Web Report - Face Counting

Device | Group | Log | Query | Custom Query User: admin  Logout

0 :0onLine @ : OffLine

> Total List
> GV-3D People Counter@®[Delete]
> GV-Smart Box@[Delete]
» TEST-308-PC@[Delete]

TEST-308-PC V-Smart Box | Gv-3D People counter
Face Face Face
counts 120 counts |2 counts |2
Male |0 Male |0 Male |0
Female |0 Female |0 Female |0
n/a 120 n/a 0 n/a 0

Total Male Count: 0 | Total Female Count: 0

» Total Male(Female): on behalf of today 0:00 until now male(female) count : E:Eiaﬁig:g;e:nfg::zgigec

s 445econds later update

Total Device Real-time Male and Female of Time-Sharing chart
S0

&0
70
0
50
40
20

20

Figure 5-2

The counts on the main page show:

m Face counts: The number of people entered and counted based on face images during

the day.

Male: The number of males entered during the day.

Female: The number of females entered during the day.

n/a: The number of entered people whose gender failed to be recognized.
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m Total Male Count: The total number of males entered from multiple GV-Smart Boxes

during the day.

m Total Female Count: The total number of females entered from multiple GV-Smart

Boxes during the day.

On the left menu, you can find these options:

m Total List: Select one GV-Smart Box or GV-System under the list to see its individual
face counts. A green mark indicates that the device is now updating data to the GV-Web
Report server; otherwise a red mark appears. On the individual device’s page, the face

counts of the current day are updated every minute from the GV-Web Report server. To

remove a device from the list, click Delete next to the device name.

© Camera: Access the live video if remote access is enabled on both the device and
GV-Web Report server. See 5.1.2 Viewing Live Video.

(2 6eovision GV-Web Report - Face Counting

Device | Group | Log | Query | Custom Query User: admin Logout

@ :0OnlLine 8 :Off Line

» Total List
» GV-3D People Counter@[Deleta]
B 5 B[Delete]

B Delate]

» Cam 1(Live View)

» Cam 2(Live View)
» Cam 3(Live View)
> Cam 4(Live View)
» Cam 5(Live View)
» Cam 6(Live View)
> Cam 7(Live View)
» Cam 8(Live View)
> Cam 9(Live View)
> Cam 10(Live View)
> Cam 11(Live View)
> Cam 12(Live View)
> Cam 13(Live View)
» Cam 14(Live View)
> Cam 15(Live View)
> Cam 16(Live View)

Face counts 124
Male 0
Female 0
nfa 124

Total Male Count: 0 | Total Female Count: 0O

» Update Frequency : 60 sec
e Last Updated: 18:27:28
» 535econds later update

+ Total Male(Female): on behalf of today 0:00 until now male(female) count

TEST-308-PC Real-time Male and Female of Time-Sharing chart

Figure 5-3
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5.1.2 Viewing Live Video

To access live video, select the desired camera from the left menu of the Device page. Make
sure remote access to GV-Systems and GV-Smart Boxes has been enabled on GV-Web
Report. See 3.6.3 Remote Access Settings for details on how to allow remote access. You
will also need to enable Webcam Server on the GV-System. See Chapter 8, DVR User’s

Manual on the Surveillance System Software DVD.

13:39:39 Play

aEm— e 0010/06/ 15 13:39:39
= 7 =
— e—|—

> B E]

Figure 5-4

By clicking the [>] icon on the Live View window, you can view the live video from the GV-
Smart Box or GV-System.
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5.2 Group Page

On the Group page, you can group different cameras from different GV-Smart Boxes and
GV-Systems, and then see the face counts of the set group.

To set up a group:

1. Select Add Group from the left menu of the Group page. This page appears.

- [FEun
(2 Geoision GV-Web Report - Face Counting

Device | Group | Log | Query | Custom Query User: admin  Logout

(] Total List Add Group
Group Groupl

GV-Smart Box

Manage Group

» Add Group Camera
o
» Maintain Group [¥] CAMERA_NAME
» Setting Group Relations
Figure 5-5

2. Name the group.

3. Select the cameras that you want to include in the group.
4. Click Submit.
5

From Total List in the left menu, select the set Group to see the sum of every face count
from those selected cameras.

On the left menu of the Group page, you can find these options:

B Total List: Access the face counts of the set groups updated every minute from the
GV-Web Report server.

®  Manage Group:
®© Add Group: Select this option to set a group.
® Maintain Group: Select this option to modify the group setting or delete a group.

®© Setting Group Relations: Drag and drop a group under another group to make it a
subgroup.
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5.3 Log Page

On the Log page, you can view the gender and age recognition results of a specified time

period and the snapshots from GV-Smart Boxes and GV-Systems.

(2 6eoUision GV-Web Report - Face Counting

Device | Group | Log | Query | Custom Query

® The page show record 1-3 , total number of records : 3
All - total number of pages: 1
Device:

Gender: | All > Device Name Camera Start Time End Time Gender Age Srigssgheot
Age: Al v GV-Smart Box- 2010-05-28 2010-05-28 N/A
_ 1 , e 0~50~5 (
Start [2010-05-28 [21 00 {00 v : vi CAMERA NAME 14:11:31 05:10:23 NiA ) g
Time: [og v GV-Smart Box- | 2010-05-28 2010-05-28 N/A g
— o i CAMERA_NAME & 14:11:31 05:11:21 7N I s Lt . =
End Time: [2010-05-28 [=] 06 |2 59 |»: oGl 5065
g = GV-Smart Box- .| 2010-05-28 2010-05-28 ale Lo (
5 ¥ i CAMERA_NAME & 14:11:31 05:11:21 Male 60~ 65 v %
DST: @selectAll OY ON
|_Query | ) =)

To search the log data:

1.

Select a specific GV-Smart Box or GV-System from the Device drop-down list or a
created group from the Group drop-down list.

Specify Gender and Age of the log data.
Specify Start Time and End Time of the log data.

You can select whether to search the DST (Daylight Saving Time) data. Select All
indicates searching all data including DST data, Y indicates searching only DST data
and N indicates not searching DST data.

Click Query to display the search results.

B Gender: You can view the gender of the person entered. N/A appears when the
GV-Smart Box fails to recognize the gender. You can also manually specify the
gender with the drop-down list if necessary. The modified data will be updated to
the database of the GV-Web Report.

B Age: You can view the age range of the person entered. You can also manually
specify the age group with the drop-down list if necessary. The modified data will
be updated to the database of the GV-Web Report.

B Image Snapshot: You can view the snapshot of the person entered by clicking the

".\_,.Il%

icon.

To back up the search results in EXCEL, WORD or PDF format, click the icons &/ = | & |

at the bottom of the Query Result List.

48



B Accessing Face Counting Page

5.4 Query Page

The Query page provides you with the daily, weekly, monthly and yearly face counting

graphs and tables. To search the face counting data, select a GV-Smart Box or GV-System

from the Device drop-down list or a created group from the Group drop-down list, specify a

date, and select the following options below. Use the Chart drop-down list [hart : [Line Graph ¥
above the graphs to choose to display the data in bar graph, pie graph or line graph.

Note: Pie graph is not available for the following types of data.

e Male Female Count per 60 Minutes

e Total Male and Female count per 60 Minutes
e Age range Count per 60 Minutes

e Total range Count per 60 Minutes.

[Daily Report] Display the face counting report of the specified date.

Male/Female count per 60 minutes: The hourly number of males and females entered
during the day.

Total male and female count per 60 minutes: The hourly accumulated number of
males and females entered during the day.

Male and female percentage: The total number and the percentage of males and
females entered during the day.

Age range count per 60 minute: The hourly number of people of each age range
entered during the day.

Total Age range count per 60 minutes: The hourly accumulated number of people of
each age group entered during the day.

Age range percentage: The total number and the percentage of people of each age
range entered during the day.
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The following figure is an example of the Male/Female count per 60 minutes option. The
value 9, 5 indicates the count of males until 9 am is 5.

[Weekly Report] Display the weekly report that contains the data of 7 days before your

- |

(2 geoUision

Dewice | Group | Log | Query

GV-Web Report - Face Counting

»> People Counting

User: 1

©Device:

Chart : | Line Graph

O Group:

Time: [2010-11-1 [] 50

Daily Report(2010-11-1)

80

Male,female count per 60 minutes

Total male and fernale count per 60
minutes

El)

Male and female percentage 0

Age range count per 60 minutes

Total age range count per 60
minutes

50

40

Age range Percentage
e 30

20

10

[2010-11-01] Male,female count per 60 minutes(All Device)

6

7

== Male

8 9

="m Female

10 11

=0 NIA

12 13

Time

Male

Female

M

sum

000

57

1:.00

16

2:00

28

2:00

<00

12

5:00

18

6:00

73

7.00

o|le|lwlo]o

16

|

specified date.

50

Figure 5-7

Male count percentage: The daily number and the percentage of males entered for the

week.

Female count percentage: The daily number and the percentage of females entered for

the week.

Male and female percentage: The total number and the percentage of males and

females entered for the week.

Age range percentage: The total number and the percentage of people of each age

range entered for the week.
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The following figure is an example of the Age range percentage option. The value 30 ~ 35,

321 (32.96%) indicates the number of 30 ~ 35 year-olds entered is 321. 30 ~ 35 year-olds

takes up 32.96 percent of all persons entered that week.

GV-Web Report - Face Counting

Q GeoUision

Device | Group | Log | Query

33 People Counting

User: 1

Logout

© Device:

Chart : | Pie Graph |+

Male count percentage

Female count percentage

Male and female percentage

Age range Percentage

®0~5

15~20 @ 20~25

[2010-10-26~2010-11-01] Age range Percentage(All Device)

30 ~ 35, 321(32.96%)

1

30~35 @ 40~45 @ 50~55 « 55~60 @ 60~65 @ 65~70

Age

Counter

Percentage%

0~5

128

13.14

15 ~ 20

70

7.19

20~ 25

377

38.71

30~ 35

321

32.96

A0 - 45

=]

>

Figure 5-8

[Monthly Report] Display the monthly report that contains the data of a month before your

specified date.

Male count percentage: The daily number and the percentage of males entered for the

month.

Female count percentage: The daily number and the percentage of females entered for

the month.

Male and female percentage: The total number and the percentage of males and

females entered for the month.

Age range percentage: The total number and the percentage of persons of each age

range entered for the month.
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[Yearly Report] Display the yearly report that contains the data of a year before your

specified date.

52

Male count percentage: The monthly number and the percentage of males entered for

the year.

Female count percentage: The monthly number and the percentage of females entered
for the year.
Male and female percentage: The total number and the percentage of males and

females entered for the year.

Age range percentage: The total number and the percentage of people of each age

range entered for the year.
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5.5 Custom Query Page

The Custom Query page allows you to look up the male or female counting data of different
age group during a specific time period. You can customize the X Axis and Y Axis of the line
graph.

1. Select a GV-System or GV-Smart Box from the Device drop-down list or select a
created group from the Group drop-down list.

2. Set a Start Time and End Time to include the counting data during that time period.

3. Toinclude only the data from specific time and days of the week, click Setting next to
Work Date. This window appears.

% Work dateSetting
sun) (06 ¥ 05 ¥| ~ 14 ¥]:[05 ¥
Mon) (00 ¥|:[00 ¥~ |24 ¥/ .

Tue) [00 ¥]: 00 v |~ 24 v,

=

=

=

=

[0 00 -2,
e [00 9] 00 ] [24
Sat) |UU V|:|UU V|~|24 v|:

=

=

(
(
(
(wed) [00 %] :[00 ¥~ [24 ] .
(
(
(

=

Figure 5-9

Specify the days of week and time range to include and click Submit.
5. Select the Age groups to include or click Select All.
6. You can set the Y Axis of the line graph to the following options:

B Male Count: Shows the average number of male counted.
B Female Count: Shows the average number of female counted.
B Total Male Count: Shows the total number of male counted.
B Total Female: Shows the total number of female counted.
7. You can set the X Axis of the line graph to the following options:
B Per hour: Shows the counting data per hour.
B Per day: Shows the counting data per day.
B Per month: Shows the counting data per month.
B Per year: Shows the counting data per year.

8. Click Query to see the line graph.
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In the example below, Male Count is selected for Y Axis and Per Hour is selected for X Axis.
The value 18, 124 indicates that average number of males counted from 17:00-18:00 pm is
124.

(2 6eovision GV-Web Report - Face Counting

Device | Group | Log | Query | Custom Query

25 ~ 20 =
30~ 35

[#]35 ~ 40 T
140 ~ 45
145 ~ 50 e
50 ~ 55
55 ~ 60 500
50 ~ 65
[vl65 ~ 70 400
70~ 75
175 ~ g0 200
80 ~ a5
[¥185 ~ a0 200
90 ~ 85 18, 124
95 ~ 100 100

T Axis: | Male Count b

® fxis: | perhour (v 0 o S e S e ; -
L] 1 2 3 4 5 B 7 8 9 10 11 1z 13 14 15 16 17 18 19 20 21 22 23 24

Male Count(per hour)

Figure 5-10

54



n Accessing Object Size Counting Page

Chapter 6 Accessing Object Size

Counting Page

After the GV-Web Report Service is started, you can access the counts, graphics and live
video on the network. The GV-Web Report is divided into 3 pages, People Counting page,
Face Counting page and Object Size Counting page. This chapter describes the functions
on the Object Size Counting page in detail.

Object Size Counting page provides counting data of vehicles that entered the surveillance
area sorted by different object sizes. The counting data can be acquired from GV-Smart
Boxes.

After logging in the Web interface, click the Object Size Counting tab on the upper right
corner of the Web page. The Web page is switched to the Object Size Counting page similar
to the following example.

@ ceouts > :
GeoUision GV-Web Report - Object Size Counting
Device | Group | Log | Query | Custom Query User: admin  Logout
@ :onLine @ : Off Line
v-smart ox V-30 Poople Counter
» GV-3D People Counter@[Delete] Level1 |0 Level1 1411 Level1 |0
, GU-Smart Box@Delete] | Level2 [o | [ Level2 [208 | | Level2 Jo |

» CAMERA_NAME(Live View) s Update Frequency : 60 sec
» Last Updated : 18:26:35

» TEST-308-PCO[Delete] + 515econds later update

Total Device Real-time cbject size of Time-Sharing chart
200

200

50

== level 1 =0O= Level2

Figure 6-1

Note: For remote viewing through network, Internet Explorer 7.0 or later is required.
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6.1 Device Page

On the Device page, you can access object size counts of the day and watch live view from
a GV-Smart Box.

Main page On the main page of the Device page, the object size counts of the
current day are updated from the GV-Web Report server every
minute. See 6.1.1 Viewing Object Size Counts Updated Every
Minute.

Live View Window On the Live View window, you can view live video from a GV-Smart
Box. See 6.1.2 Viewing Live Video.

6.1.1 Viewing Object Size Counts Updated Every Minute

The data on the main page of the Device page is updated every minute from the GV-Web
Report server. The page displays the object size counts and graphs of all connected GV-
Smart Boxes.

(2 Geoision GV-Web Report - Object Size Counting

Device | Group | Log | Query | Custom Query User: admin  Logout

@ :0nLine ®:0OffLine
» Total List TEST-308-PC GV-Smart Box GV-3D People Counter
» GV-3D People Counter@®[Delete] Level1 |0 Level1 411 Level1l |0

+ GV-Smart Box@[Delete] [ Levelz |0 | | Level2 [2908 | [ Levelz Jo |

> CAMERA_NAME(Live View) * Update Frequency : 60 sec
g apc®1 » Last Updated : 18:36:35
TEST-308-PC@[Delete] s 51Seconds later update

Total Device Real-time object size of Time-Sharing chart

== Level1 =Om= Level2

Figure 6-2

The table on the main page shows the number of objects counted for each size level. Three

graphs are available.

m Real-time object size: The hourly number of objects from different size levels counted
on that day is shown in a line graph.

m Real-time total object size (All Device): The accumulated number counts from different
size levels for all connected device are shown during the day in a line graph.

m Real-time total object size (Each Device): The daily accumulated object counts of
different size levels from each device are shown in a bar graph.
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On the left menu, you can find these options:

m Total List: Select one GV-Smart Box under the list to see its individual object size counts.
The green mark indicates that the device is now updating data to the GV-Web Report
server; otherwise a red mark appears. The object size counts of the current day are
updated every minute from the GV-Web Report server. To remove a device from the list,

click Delete next to the device name.

© Camera: Access the live video if remote access is enabled on both the device and

GV-Web Report server. See 6.1.2 Viewing Live Video.

GeoUision GV-Web Report - Object Size Counting
Device | Group | Log | Query | Custom Query
@ : OnLine @ : Off Line
Total List TEST-308-PC
» GV-3D People Counter@[Delete] Level 1 |0 Level 1 411
> GV-Smart Box®[Delete] Cevelpg o Cevell?y 258
» CAMERA_NAME(Live View) « Update grquencv : 60 sec
- + Last Updated : 18:37:35
> TEST-308-PC@[Delete] * 25Seconds later update
I Tobol H = 1 &5 b P £ T3 i~

Figure 6-3

6.1.2 Viewing Live Video

To access live video, select the desired camera from the left menu of the Device page. Make
sure remote access to GV-Smart Boxes has been enabled on the GV-Web Report. See
3.6.3 Remote Access Settings for details on how to allow remote access.

AL

Figure 6-4

By clicking the [>] icon on the Live View window, you can view the live video from the GV-

Smart Box.
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6.2 Group Page

On the Group page, you can group different cameras from different GV-Smart Boxes, and
then see the object size counts of the set group.

To set up a group:

1. Select Add Group from the left menu of the Group page. This page appears.

Q Ll - . .
GeoUision GV-Web Report - Object Size Counting
Device | Group | Log | Query | Custom Query User: admin  Logout

» L1 GroupA Group Groupl

GV-Smart Box
Manage Group Camera
v
, Add Group ] CAMERA_NAME

- Maintain Group

» Setting Group Relations
» Maintain object size name

Figure 6-5
2. Name the group.
3. Select the cameras that you want to include in the group.
4. Click Submit.
5

From Total List in the left menu, select the set Group to see the sum of every object size
count from those selected cameras.

On the left menu of the Group page, you can find these options:

B Total List: Access the object size counts of the set groups updated every minute from
the GV-Web Report server.

®  Manage Group:
®© Add Group: Select this option to set a group.
® Maintain Group: Select this option to modify the group settings or delete a group.

®© Setting Group Relations: Drag and drop a group under another group to make it a
subgroup.

B Maintain Object Size Name: Modify the display names to 6 different object sizes
defined for Traffic Counter in the GV-Smart Box.
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Object size level

n Accessing Object Size Counting Page

Name

1

|Eiu5|

|Bic~_.fcle

|Truck

|M0t0rc~_.fc|e

|‘u’ehic|e

Lo T I T O N S T ) 8

|Leve| &

Figure 6-6
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6.3 Log Page

On the Log page, you can view the counting records according to different object sizes

during a specified time period from GV-Smart Boxes.

Object Size Countmg[v]

Q - . _ -
Geoision GV-Web Report - Object Size Counting
Device | Group | Log | Query | Custom Query User: admin  Logout
S The page show record 1-5 , total number of records : 5
@ Device: |All [v] total number of pages : 1
O Group:
. .p Query Result Lis
Object size Al [v] Object si
level: Device Name Camera levef'ze Direction| Color Start Time End Time
Direction: |All_v] GV-Smart 2012-02-06 2012-02-06
Color: [Al [v] Box (M |CAMERA_NAME €| moforcydle | Out | Red 15:12:56 15:12:56
" [2012-02-06 21 [15]~]: GV-Smart - 2012-02-06 2012-02-06
Start Time: 2 [l ]560] ] Box (M CAMERA_NAME | motorcycle out | Red 15:12:56 15:12:56
= GV-Smart . 2012-02-06 2012-02-06
End Time: 2Ufzi02_F5] L Box[M  |CAVERA_NAME @ moforcycle | Out | Red 15:12:56 15:12:56
12w )| 58 |»
GV-Smart 2012-02-06 2012-02-06
- -
DST: @ select Al OY ON pox M |CAMERA_NAME =y m |eiiE 15:12:58 15:12:58
| query | GV-Smart } . 2012-02-06 2012-02-06
Box M |CAMERA_NAME & car s 15:12:58 15:12:58
= = B8
Figure 6-7

To search the log data:

1. Select a specific GV-Smart Box from the Device drop-down list or a created group from
the Group drop-down list.

2. Specify the Direction to see the counting results of objects moving In or Out.
3. Specify Start Time and End Time of the log data.

4. You can select whether to search the DST (Daylight Saving Time) data. Select All
indicates searching all data including DST data, Y indicates searching only DST data
and N indicates not searching DST data.

5. Click Query to display the search results.

B Object Size Level: You can view the size level of the object detected. You can
define up to 6 object size levels in the GV-Smart Box and label the different object
size levels under the Group Page. See Figure 6-6.

B Direction: You can see whether the object is moving toward the In or Out direction
defined in the GV-Smart Box.

To back up the search results in EXCEL, WORD or PDF format, click the icons | [+ | 1 ]

at the bottom of the Query Result List.
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6.4 Query Page

The Query page provides you with the daily, weekly, monthly and yearly object size counting
graphs and tables. To search the object size counting data, select a GV-Smart Box from the
Device drop-down list or a created group from the Group drop-down list, specify a date, and

select the following options below. Use the Chart drop-down list [hart : [Line Graph ¥ | above the
graphs to choose to display the data in bar graph, pie graph or line graph.

Note: Pie graph is not available for the following types of data.
e Object size count per 60 minutes

e Total object size count per 60 minutes

[Daily Report] Display the object size counting report of the specified date.

m  Object size count per 60 minutes: The number of objects from each object size level
counted per hour.

m Total object size count per 60 minutes: The accumulated number of objects from each
object size level counted per hour.

m  Object size percentage: The total number and the percentage of objects from each

object size level counted on that day.

The following figure is an example of the Object size count per 60 minutes option. The
value 20, 6478 indicates the number of cars counted from 19:00-20:00 pm is 6478.

Object Size Cuuming[v]

GeoUision GV-Web Report - Object Size Counting
Device | Group | Log | Query | Custom Query User: admin  Logout
®pevice:  |Al [+ Chart : | Line Graph |~
O Group:
s - [2012-02-06] Object size count per 60 minutes(All Device)
Date: 8,000
Time interval: | 0:00 [Vlw 23:[][][*']
7,000 20, 6,478
5
Object size count per 60 minutes £,000
Total object size count per 60 minutes
Object size percentage 5,000
(2012-1-31~2012-2-6)
4,000

2,000
1,000
[

15 18 13 20 21

=C= Motorcycle  =0= Car

Time Motercycle Car Sum
15:00 1,051 1,063 2,114

18:00 4,248 3,730 7,987

19:00 7,418 6,526 13,044
20:00 7,463 6,478 13,041
21:00 1,172 982 2,154

Sum 21,352 18,788 40140

Figure 6-8
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[Weekly Report] Display the weekly report that contains data of the 7 days before your
specified date.

m  Object size percentage: The daily number and the percentage of objects from each
object size level counted for the week.

m Level X percentage: The daily number of objects from the selected object size level
counted and the percent of total weekly count. If you have customized the name of the
size level in the Group page, the modified name will be displayed here.

Below is an example of the weekly Object size percentage. The value Motorcycle, 1,176
(2.84%) indicates that the number of objects from the Motorcycle size level counted is 1,176
for that week. Motorcycles takes up 2.84 percent of all traffic counted that week.

° o 5 .
(2 GeoUision GV-Web Report - Object Size Counting
Device | Group | Log | Query | Custom Query User: admin  Logout
® pevice:  |All [v] Chart : |Pie Graph [v] B
OGroup:

[2012-02-10] Object size percentage(All Device)

Time | 0:00 M
interval: ., 23;00M
(2012-2-4~2012-2-10)

Object size percentage

Motorcycle, 1,176(2.84%) |

PeoplePercentage
BicyclePercentage
TruckPercentage

MotorcyclePercentage

VehiclePercentage
Level 6Percentage

(2012-1-11~2012-2-10)
(2011-2-11~2012-2-10)

& People Bicycle @ Motorcycle “ehicle

Object size level Counter Percentage%
People 5,058 12.21
Bicycle 28,577 69
Motorcycle 1,176 2.84
Vehicle 6,606 15.95
Sum 41,417 100
Figure 6-9

[Monthly Report] Display the monthly report that contains the data of a month before your
specified date.

m  Object size percentage: The total number and the percentage of objects from each
object size level counted for the month.

[©)]
N
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m Level X percentage: The number of objects from that size level counted each day for a
selected month is shown, as well as the percent of total monthly count. If you have
customized the name of the size level in the Group page, the modified name will be
displayed here.

Below is an example of the monthly Car percentage. Object size level 2 defined in GV-
Smart Box was renamed to Car in the Group page. The value 12-02-06(Mon), 18,788
(96.95%) indicates that the number of objects from the Car size level counted is 18,788 on
2012/02/06 and it takes up 96.95 percent of all traffic counted that month.

(2 Geovision GV-Web Report - Object Size Counting

Device | Group | Log | Query | Custom Query User: admin  Logout

® Devica: Chart ; | Pie Graph v

OGroup:
Date: [2012-2-11 [
Time [q.r ;
interval: |_D'_DDZ|“ 2300 v

[2012-02-05~2012-02-11] Car Percentage(All Device)

2012-02-06(Mon), 18,788(96.95%)

Object size percentage
Motorcycle Percentage
Car Percentage
BicyclePercentage
TruckPercentage

Level sPercentage
(2011-2-12~2012-2-11)

@ 2012-02-D6(Mon) & 2012-02-08(\Wed) & 2012-02-08(Thu)

Time Car Percentage®%
2012-02-06(Man) 18,788 956,95
2012-02-02(Wed) 569 2.94
2012-02-09(Thu) 22 0.11

Sum 19,379 100

Figure 6-10

[Yearly Report] Display the yearly report that contains the data of a year before your
specified date.

m Object size percentage: The monthly number and the percentage of objects from each
object size level counted.

m Level X percentage: The number of objects from the selected object size level counted
is shown by month as well as the percent of yearly count. If you have customized the
name of the size level in the Group page, the modified name will be displayed here.
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6.5 Custom Query Page

The Custom Query page allows you to look up the object counting data of different size

levels during a specific time period. You can customize the X Axis and Y Axis of the line

graph.

64

Select a GV-Smart Box from the Device drop-down list or select a created group from
the Group drop-down list

Set a Start Time and End Time to include the counting data during that time period.
To include only the data from specific time and days of the week, click Setting next to
Work Date. This window appears.

N o tesetting

[ (sun) |06 ¥|: (05 ¥ ~ 14 v|:|05 v
[ (Mon) {00 %] ;{00 jv| . |24 (¥,

& (tue) [00 ¥ :[00 %] . [24 ] .

[ (wed) [00 ¥|: |00 v| |24 v|.

[ (Thu) [00 v |: 00 | [24 v,

& (Friy |00 ] :[00 v . [24 ]

[ (sat) |00 ¥|:|00 ¥ . |24 ¥/,

Figure 6-11

Specify the days of week and time range to include and click Submit.
You can set the Y Axis of the line graph to the following options:

H  Level 1-6: Shows the number of objects from that size level counted. If you have
customized the name of the size level in the Group page, the modified name will
be displayed here.

You can set the X Axis of the line graph to the following options:
B Per hour: Shows the counting data per hour.

B Per day: Shows the counting data per day.

B Per month: Shows the counting data per month.

B Per year: Shows the counting data per year.

Click Query to see the line graph.
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In the example below, the average hourly motorcycle count from 2/2 to 2/8 is shown in a line
graph. The value 18, 4248 indicates that between 2/2 and 2/8, the average number of
motorcycles counted from 17:00-18:00 pm is 4248.

Object Size Counting M

(2 Geovision GV-Web Report - Object Size Counting

User: admin  Logout

Device | Group | Log | Query | Custom Query

@® [ select Al
Device: [ Gv-Smart Box Motorcycle (per hour)
[ Gv-Smart Box 8,000
¥l Gv-smart Box
® Select All
Group: GroupA

= €,000
start[2012-2-2 =100+ ]:
Time: g s|: 00w
u u _ 5,000
End[2012-02-08 =] 23] ]: 18, 4,248

Time: 5gM: 5gM AT

Work e
date: Setting .

¥ Axis: Mumrcyclem
X Axis: | per hour M 2,000

7,000

1,000

o 1 2 2 4 5 & 7 8 9 10 11 12 13 14 153 16 17 18 19 20 21 22 23 24

== GV-Smart Box =Cm= GV-Smart Box =C= GVY-Smart Box

Figure 6-12
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Chapter 7 Mobile Phone Connection

Using iPhone, iPad or other mobile devices with built-in Android OS, you can view people
counting and face counting results on your mobile phone. After logging in, you can query the

data and chart for people counting and face counting results.

1. On your mobile device, type the IP address of the GV-Web Report server in the address
field of the browser. The login dialog box appears.

m

4 g

Sign In with your account

: )

Password: [ ]

©

O Remember my Account and Password

Figure 7-1

2. Type the account ID and password.

3. Click Login. The People Counting results for that day appear.

i
Untitied
« E A 4 | 192.168.0.199/App/Counter_Live_mabile.... ¢ |(

data | Chart

People Counting [ 2010-11-01 ] Logout

Device : [ All v
GV-Smart Box
In 721
Out 456

Average In |1
Average Out |0

Total In: 721 | Total Out: 456 | Stay: 265

» Total In(Out): on behalf of today 0:00
until now In(Out)

» Average In(Out): on behalf of today
0:00 until now average In(Out) per
minute

Figure 7-2
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4. To see the data of other devices, tap the Device drop-down list.

5. To see graphs of the results, tap the Chart tab on the top. This window appears.

T 2F4:42
Untitied

| © M 4+ | 192168.0.199/App/Counter_Live_mobile.... & |
Data | Chart People Counting [z

Date : [ 2010-11-01 | [ Logout

Device : | Al v
2010-11-01

InfOut Counts per hour and Total Stay
300

230
200
150
100

50 & A0

Figure 7-3

6. Tap the Date drop-down list to select a date and tap the Device drop-down list to select
a device.

7. Use the Type drop-down list to display the results of that day, week, month or year.

8. To switch to Face Counting results, tap the People Counting button on the top-right
corner and select Face Counting. The Face Counting results for that day appear.

Untitied

4 G @3+ [192.168.0.199/mpp/Counter_Live_F_mobi.. ¢,
Data | Chart (Face Couning_ o)

Face Counting [ 2010-11-01 ] Logout
Device : | All v

GV-Smart Box

Face counts |974
Male 391
Female 455
n/a 128

Total Male Count: 391 | Total Female
Count: 455

* Total Male(Female): on behalf of today
0:00 until now male(female) count

Figure 7-4
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9. To see the data of other devices, tap the Device drop-down list.

10. To see graphs of the results, tap the Chart tab on the top. This window appears.

uuuuuu

4 I 0 4  792182.0.199A80 Counts Lve_F_mobi... ¢ |(

Data | Chort
Date : [ 2010-11-01 |[F] Logout

Device : [ Al E2
Type : | Daily Report v
2010-11-01

Male, female count per 60 minutes
100 -

.-'!"-'

a0 -

Figure 7-5

11. Tap the Date drop-down list to select a date and tap the Device drop-down list to select
a device.

12. Use the Type drop-down list to display the results of that day, week, month or year.
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Appendix

A. Enabling UPnP in Windows XP

1. Go to Windows Start, click Start button, select Settings, and select Network
Connections. This window appears.

Appendix

%, Network Connections

=181 x|

File Edit “iew Favorites Tools Advanced Help

| 4

'\_)Back - L\_;l - lj} /.__J Search | Folders ‘ = (¥ x n ‘ -

Address |€_\ MNetwork Connections

=B
Hame | Type | Status | Device Mame | Phone # or Host Address I Qwner |
LAN or High-Speed Internet
<L Local Area Connection LAM or High-Speed Inter... Connected Realtek RTLE139 Family ... System

This dialog box appears.

- Local Area Connection Properties

Generall Autherttication Advanced I

Windows Firewall

Pratect my computer and network by limiting
of preventing access to thiz computer from
the Intermet

Click the Settings tab, and click Exceptions tab. This dialog box appears.

%= windows Firewall

General  Exceptions | Advanced |

x|

“Wwindows Firewall is turned off. Your computer is at risk of attacks and intrusions
fram outside sources such as the Intemet. We recammend that you click the
General tab and select On.

Progiams and Services:

Name

[JFile and Printer Sharing
Remote Assistance

Add Program. Add Part... Edi.. Delete

W Display a notification when Windows Firewall blocks a program

w'hat are the risks of allowing exceptions?

Cancel

4. Select UPnP Framework, and click OK.

Right-click one Local Area Connection, select Properties, and click the Advanced tab.
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B. Modifying Port Number for running GV-Web Report on the same

computer with GV-System

Since the GV-Web Report server and the WebCam Server of GV-System share the same
HTTP port number of 80 to connect to the Web, it is required to modify the port number of
either GV-Web Report or WebCam Server if both of them are running on the same computer.
If not, the following message will appear and you cannot access the Web interface of the
GV-Web Report server:

Starting Web Server Failed

To modify the HTTP port number of GV-Web Report:
1. Click Tools from the menu bar and select General Setting.

2. Inthe Web Server section, change the default Listen Port of 80 to a different port number
within the range of 1024 to 65535.

3. Click Apply.
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